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TP1 Découverte du SIG MapInfo : visualisation d’information 

 

0. Objectifs 

Ce premier TP a pour objectif de vous faire découvrir le SIG bureautique MapInfo Professional® . Nous 
utiliserons ce logiciel, dans sa version 8.0, tout au cours de cet enseignement. Au cours de ce TP, nous 
nous limiterons à une découverte des capacités de bases offertes par le logiciel en matière de visualisation 
d’information géographique. Cette TP sera également l’occasion de faire le lien avec certaines notions 
générales sur les SIG étudiées en cours. 

Ce sujet de TP est divisé en plusieurs parties. Chaque partie suivra la même structure : dans un premier 
temps, un petit tutoriel vous présente certaines fonctionnalités du logiciel. Suit une partie exercice, où il vous 
est demandé d’utiliser ces fonctionnalités pour répondre à certaines demandes. 

1. Structure de données et visualisation de carte 

1.1. Structures de données MapInfo 

Comme dans tout SIG (cf. cours sur la modélisation informatique de l’information géométrique), la 
représentation de l’information géographique dans MapInfo Professional®  est séparée entre information 
sémantique et information géométrique. Au minimum, une base de données MapInfo Professional®   
contient des données sémantiques tabulaires (comme dans un SGBD-R classique), qui sont représentées 
par deux fichiers différents qui ne diffèrent que par leur extension 

- Fichier nomfic.tab , qui décrit la structure de la table considérée, i.e. le format du fichier de données 
utilisé, avec en particulier la liste des attributs et leur type.  

- Fichier nomfic.dat , qui contient les données à proprement parler. Notons que MapInfo Professional®    
assure une compatibilité directe avec de nombreux autres outils. Ainsi, si les données tabulaires 
proviennent de Microsoft Excell, le fichier se dénommera directement nomfic.xls . On peut de même 
intégrer des données issues de dBASE, Microsoft Access ou Lotus 1-2-3 etc… 

Le plus souvent, ces données sont bien entendues associées à une information géométrique. Dans le cas 
d’un codage vectoriel, deux nouveaux fichiers sont alors associés à la base de données : 

- Fichier nomfic.map , qui décrit les objets géométriques vectoriels.  

- Fichier nomfic.id , qui décrit les correspondances entre les données sémantiques et géographiques (cf. 
le chapitre du cours consacrée à la modélisation dans les SIG). 

L’information géographique peut également être indexée pour faciliter l’interrogation de la base de données 
(cf. chapitre du cours sur l’indexation spatiale). On disposera dans ce cas d’un fichier additionnel 
nomfic.ind . 

Dans le cas d’un codage raster, il n’y a bien entendu pas de notion d’objet géographique. Les données sont 
donc décrites comme des données brutes. Simplement, le fichier ne sera pas dénommé nomfic.dat  mais 
prendra au contraire l’extension correspondant au type d’image utilisé (ECW, SID, BMP, JPG, GIF, TIF…).  

1.2. Ouverture de tables MapInfo préexistantes et visualisation 

Pour utiliser une nouvelle BD géographique, il faut charger (Fichier>Ouvrir ) le fichier tab  correspondant: 
MapInfo Professional®  ira automatiquement chercher les autres fichiers en relation avec la table1. 

Après chargement de la table, MapInfo Professional® affiche les données brutes. En particulier, deux types 
de vues peuvent être obtenues à partir du menu Fichier  (cf figure 2) : 

- Visualisation des objets géographiques en mode Carte .  
- Visualisation des données attributaires (sémantiques) associées à ces données en mode Données . 

On remarquera que le menu principal et les palettes flottantes d’outils changent suivant le mode employé. 

                                                           
1 Notez au passage (figure 1) que vous pouvez ouvrir a priori tous les types de fichiers connus de MapInfo : par 
exemple, vous pouvez ouvrir une table Microsoft Excell� pour visualiser voire modifier certaines données attributaires. 



 

Figure 1. Chargement d’une base de données MapInfo 

 

 

Figure 2. Vues Carte et Données dans MapInfo 

En mode Carte , vous pouvez modifier certains paramètres dans le menu Carte > Options . Cela vous 
sera en particulier utile pour choisir le système de projection à employer pour l’affichage (figure 3). Notez 
que ces options ne sont pas propres à la carte affichée, mais au système et seront conservées pour 
l’utilisation suivante. Les options pilotables à partir de la palette d’outil général  sont au contraire 
spécifiques à la carte affichée. 
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Figure 3. Choix du système de projection dans MapInfo 

 

Figure 4. Palette d’outil général en mode Carte (à gauche) et mode Données (à droite) 

En mode Données , le sous-menu Données > Choisir Champs  permet de choisir les champs de la table à 
afficher, de changer leur ordre d’apparition et de les renommer. Si l’on fait le parallèle avec SQL et l’algèbre 
relationnelle, ces paramètres reviennent à réaliser une vue ne mettant en jeu que des projections. 

 

Figure 5. Paramétrage de l’affichage des données attributaires 

Sélection d’un objet géographique 

Zoom ou déplacement de la carte 

Affiche toutes les données attributaires de l’objet sélectionné 

Affiche l’étiquette associée à l’objet sélectionné 



 

 
Travail à réaliser 

Les fichiers de données à utiliser sont récupérables sur le forum ou la page WWW consacrée à ce cours.  

1. Chargez la table contenant les informations sur les départements français (fichier Departmt.tab ). 

2. Accordez à la carte la moitié de l’espace de travail MapInfo, zoomez et centrez au mieux la carte de 
France dans cette fenêtre. Affichez à côté, suivant les mêmes dimensions, les données attributaires 
relatives à ces départements. 

 

3. Etudiez l’influence du système de projection en retenant différentes projections étudiées en cours 
(Lambert RGF-93, Mercator WGS 84, UTM…) en retenant les projections adaptées à la zone 
considérée. Qu’observez-vous ? Zoomez uniquement sur un département : comment ce traduit 
principalement le changement de projection à ce niveau de représentation ? 

4. Quel est le département français le moins peuplé ? Sélectionnez-le pour le mettre en évidence sur la 
carte. 

5. Affichez l’étiquette des 5 départements bretons historiques (Finistère, Côte d’Armor, Morbihan, Ille-et-
Vilaine, Loire-Atlantique), i.e. avant le rattachement de la Loire-Atlantique à la région des Pays-de-Loire 
par le gouvernement Pétain en 1940. Quel champ joue le rôle d’étiquette dans la table des données 
attributaires ? ® 

 

6. Sortez de MapInfo Professional®  et allez voir (par exemple avec le Bloc Notes Windows) la structure de 
la table des données attributaires. Quels sont les champs indexés ? Le champ jouant le rôle de clé 
primaire est-il indexé ? Ouvrez maintenant la table même (et non pas sa structure) pour en découvrir le 
contenu : retrouve-t-on bien les données attributaires visualisées dans MapInfo Professional® . 



7. Modifiez la vue des données pour se limiter (projection) à l’affichage de code et du nom du département, 
ainsi que de sa population totale (plus le détail de la population masculine et féminine) en 1990, qui sera 
également mise en regard de la population étrangère. 

8. Quelle était la proportion de population étrangère de la ville/département de Paris en 1990 ? Comparez 
ce résultat avec celui de la Lozère. 

1.3. Analyse thématique : première découverte 

MapInfo Professional®  ne se contente pas d’afficher des données brutes. C’est également un outil puissant 
pour faire de l’analyse de l’information géographique. Nous consacrerons plus loin une séance TP à ce sujet 
particulier. Dans un premier temps, nous allons simplement réaliser quelques analyses thématiques 
sommaires pour donner une idée des fonctionnalités de base en la matière. Celles-ci sont accessibles à 
partir du Menu Carte > Analyse Thématique . Chaque outil est hautement paramétrable    

L’analyse thématique permet de visualiser de manière graphique les données attributaires (un ou plusieurs 
champs) liées aux objets de la carte. En particulier, les outils proposés par MapInfo Professional®  
permettent : 

- Outils Classes  – Coloration de la carte en fonction de la valeur donnée d’un champ (figure 6a). 

- Outils Barres  – Ajout d’histogrammes sur la carte à partir de la valeur d’un ou plusieurs champs (fig. 6b) 

- Outils Symboles  – Ajout de symboles de taille variable en fonction de la valeur du champ (figure 6c). 

  

 

Figure 6. Analyse thématique sous MapInfo Professional® . a) classes de couleurs (en haut à gauche) ; b) 
barres (en haut à droite) ; c) symbole (en bas) 

On remarquera que le lancement de l’outil d’analyse thématique entraîne la création d’une nouvelle vue. 
Celle-ci peut être modifiée à partir du menu Carte > Modifier Analyse Thématique . 



Travail à réaliser 

Faites les analyses thématiques suivantes :  

9. Coloriez les départements en fonction de leur population. On définira une échelle de 10 couleurs en 
choisissant une échelle bicolore pour bien distinguer les départements surpeuplés de ceux en voie de 
désertification. Etudiez l’influence du type de catégorisation : même nombre d’objets par classe, 
amplitude fixe, par quantiles. Avez-vous bien compris les principes de ces catégorisations ? 

10. Réalisez la même opération mais en utilisant cette fois des symboles de taille proportionnelle à la 
population du département. Etudiez l’influence de l’échelle de valeurs utilisée (linéaire, logarithmique…) 

11. Faites une analyse mettant en regard, sous forme d’histogrammes, la population féminine et la 
population masculine de chaque département. La population féminine sera affichée en rouge et la 
population masculine en bleu. Faites en sorte que les histogrammes soient « présentables » en jouant 
sur leur hauteur ou leur largeur 

2. Couches d’information 

Un SIG ne prend vraiment toute sa dimension que lorsqu’il travaille avec plusieurs couches de données. 
Rappelons que ces couches correspondent à autant de données indépendantes dont le seul point commun 
est d’être géoréférencées dans le même espace géographique. Cette indépendance fait que, dans MapInfo 
Professional® , chaque couche est représentée par une base de données spécifique. Pour charger 
plusieurs couches de données, il suffit donc de charger les différents fichiers .tab  qui correspondent aux 
données recherchées. Une fois que les données sont chargées, l’affichage superposé des différentes 
informations est géré à partir du menu Carte > Contrôle des couches . 

 

Figure 7. Boite de dialogue de gestion des couches sous MapInfo Professional®.  

Le contrôle des couches sous MapInfo Professional® est assez fin : 

- Organisation  de la hiérarchie des couches (boutons Monter et Descendre) – Les couches supérieures 
peuvent le cas échéant masquer l’information apportées par les couches qui leur sont inférieures. Vous 
pouvez choisir de rendre opaque ou transparente une couche vectorielle (cf. infra : paramètres 
d’affichage) alors qu’une couche raster sera toujours opaque. 

- Mode d’utilisation  des couches – Ceux-ci sont contrôlables dans les quatre colonnes sélectionnables 
en regard de chaque couche (cf. figure 7). La première colonne (symbolisée par ) précise si la couche 
doit être visible ou non. La seconde ( ) précise si l’information présente dans la couche peut-être 
modifiée, la troisième ( ) si les objets représentés dans la couche sont sélectionnables. Enfin, la 
dernière colonne ( ) précise si les étiquettes associées aux objets de la couche doivent être affichés. 

- Paramètres d’affichage  – Ces paramètres sont modifiables à l’aide des boutons Affichage , Style  et 
Etiquettes . Ils permettent par exemple de changer la couleur des polygones d’une couche, l’épaisseur 
et la couleur de leur contour, les symboles utilisés pour représenter les objets ponctuels etc… Notons 
que ces paramètres sont spécifiques à chaque couche. Il faut donc sélectionner la couche désirée avant 
de la paramétrer. 



Ces paramètres de contrôle ne sont pas limités à une utilisation multi-couche de l’information géographique. 
Si vous travaille avec une seule couche (comme dans le §1.1), ces contrôles restent totalement accessibles. 

On remarquera que MapInfo Professional® ajoute automatiquement une couche dessin au projet en cours. 
Il est en effet possible de rajouter des éléments sur une vue. Nous étudierons plus tard cette fonctionnalité, 
notons simplement pour le moment que cette couche est bien entendu modifiable et qu’elle est toujours 
placée en première position dans la hiérarchie. 

 
Travail à réaliser 

Nous allons maintenant superposer plusieurs types d’informations concernant la France.  

12. Chargez les tables Departmt , F_routes , F_hydro  et F_villes  correspondant respectivement à la 
description des départements français, le réseau routier principal, les principaux cours d’eaux et enfin 
l’ensemble des villes françaises. Rappelons qu’en France, une ville est une commune dont la 
population dépasse les 3000 habitants. 

13. La couche Departmt  est-elle opaque ? Vérifiez-le. 

14. Modifiez le contrôle des couches pour avoir le bel affichage ci-dessous : la France sera représentée 
sous un fond jaune pastel, les limites départementales seront en orange clair. Les cours d’eau seront 
représentés en bleu outremer et le réseau routier en noir. Enfin, les villes seront représentées par de 
petits carrés orange avec bordures. 

 

15. Avant que l’automobile ne tisse son envahissante toile autoroutière et le train ses voies ferrées, les 
transports se faisaient principalement par voie d’eau, et ce depuis l’antiquité. C’est pourquoi les 
principales villes françaises sont situées au bord des côtes ou le long des cours d’eau. Vérifiez ce point 
en augmentant l’épaisseur des cours d’eau sur votre affichage et en ne conservant que les couches 
villes et hydrologie. 

 

16. Faites désormais un affichage limité aux départements et aux villes. Affichez le nom de ces villes. 
Faites des opérations de grossissement (ou inversement). Qu’observez-vous ? 



17. On désire maintenant n’afficher que le nom des villes les plus importantes, tout en conservant un 
affichage des points correspondant à toutes les villes françaises. La table Ville_50 concerne 
précisément les villes de plus de 50 000 habitants. En jouant sur les couches, sauriez-vous répondre à 
la demande ? 

 

18. En utilisant les données du répertoire EUROPE, établissez la carte ci-dessous des pays européens et 
de leurs capitales (système de projection : Mercator WGS 84) 

 

 

3. Intégration de données Raster 

Une image raster peut également tenir lieu de couche d’information et servir, par exemple, de fond de carte 
à des objets provenant de couches vectorielles. MapInfo Professional®  accepte tous les formats d’image 
standards (BMP, PCX, GIF, TIF, JPG…). Pour pouvoir être coordonnée avec les autres couches 
d’information, l’image Raster doit être préalablement recalée à l’aide de points géodésiques qui seront 
pointés sur l’image et pour lesquels on précisera les coordonnées géodésiques. A l’issue de l’opération de 
calage, MapInfo Professional®  créera une fichier table .tab  permettant de manipuler l’image raster comme 
toute autre couche d’information.  

Calage  – Lors du chargement de l’image, MapInfo Professional®  nous demande si nous voulons caler 
cette dernière ou simplement l’afficher en l’état : si l’on choisit l’option Calage , une boite de dialogue 
s’ouvre, qui nous permet de définir autant de points que nécessaire. Typiquement, on pointe tout d’abord 
sur l’endroit recherché dans l’image. MapInfo Professional® indique alors les coordonnées du point dans 



l’image. Il ne reste plus qu’à préciser les coordonnées géographiques du point dans le référentiel choisi. 
Attention, vous devez choisir le même référentiel que les autres couches que vous souhaitez utiliser, car il 
n’est pas possible ici de changer ensuite de référentiel comme pour une image vectorielle. 

   �     

Figure 8.   Boite de dialogue de gestion des couches sous MapInfo Professional®.  

Finalisation  – A la fin de l’opération, l’image est calée et un fichier .tab  est créé. Il est toujours possible de 
modifier les points de calage à partir du menu Table > Image Raster > Modifier Calage . Enfin, en 
allant dans les Paramètres  du menu Table > Image Raster , vous pouvez rendre l’image transparente afin 
de faciliter son intégration avec d’autres couches de données. Une couleur sera utilisée pour gérer cette 
transparence (blanc par défaut). 

 

Figure 9.   Paramétrage d’une image Raster : luminosité, constraste et transparence 

Travail à réaliser 

On désire réaliser une carte de France représentant à la fois le réseau hydrographique principal et le relief 
de la métropole. Nous avons déjà travaillé avec une couche vectorielle représentant les principaux cours 
d’eau français. Ici, il faut ajouter en fond une image raster du relief : utilisez pour cela le modèle numérique 
de terrain sauvegardé dans le fichier image Mnt_France.tif .  Cette image n’est pas calée. 

19. Combien de points de calage sont-ils nécessaire au minimum ? 

20. Faites appels à vos connaissances de géographique, et choisissez un nombre suffisant de points 
géodésiques pour le calage. Cherchez leurs coordonnées sur la Toile (Wikipedia, GoogleMaps, 
Geoportail.fr) et utilisez les informations recueillies pour caler la carte. 

21. Fermez la carte et consultez, avec le bloc_notes Windows, le fichier .tab  créé par MapInfo. Quelles 
informations retrouvez-vous ? 

Zoom sur 
image 

Choix 
projection 

Déplacement 
dans l’image 

Définition des 
points de calage 



22. Tentez maintenant de superposer l’image calée obtenue avec la représentation vectorielle du réseau 
hydrographique. En cas de calage imparfait, il vous reste à reprendre vos points … ou à vous assurer 
que vous travaillez bien sur le même référentiel géodésique. 

4. Géo-localisation et sauvegarde d’environnement 

4.1. Géo-localisation de données attributaires pré- existantes 

Nous avons vu en début de TP que lorsqu’on dispose de données géolocalisées, un fichier .map  permet 
d’assurer la liaison entre l’information sémantique et sa localisation. Si l’on dispose de données 
sémantiques isolées (par exemple fichier Excell décrivant la population de certaines villes), il est possible de 
les géo-localiser et de créer un fichier .map (ainsi que les .tab et .id connexes) pourvu qu’on rajoute dans 
le tableur les coordonnées géographiques des objets concernés. 

Une fois les données complétées, il suffit d’ouvrir le fichier tableur correspondant (MapInfo Professional® 
reconnait la plupart des formats existants) pour lancer la création du fichier .map . Spécifiez tout d’abord la 
plage de valeurs du tableur que vous voulez conserver dans votre application. 

 �  

Ensuite, l’option Table > Créez des points  vous permet de définir la géo-localisation de vos objets 
(enregistrements de la table) en précisant les champs qui jouent le rôle de coordonnées dans votre table. 
Les coordonnées doivent être rentrées en degrés décimaux. Ainsi, 25°30’ N correspondra à la valeur 25. 5. 

La commande Fichier > Enregistrer Table Sous  permet au final de créer tous les fichiers pour rendre 
les données utilisables dans une couche d’information. 

 

Figure 10.   Géo-localisation d’un fichier de données : création des points 

4.2. Sauvegarde de l’environnement de travail 

L’organisation de vos couches de données, le paramétrage de leur présentation, est un travail souvent 
fastidieux que vous pouvez vouloir retrouver rapidement lors d’une session ultérieure. Cet environnement de 
travail peut-être sauvegardé par MapInfo Professional® dans un fichier de configuration d’extension.wor .  

 
!Workspace 
!Version 600 
!Charset WindowsLatin1 
Open Table "C:\antoine\ENSEIGNEMENT\M1_SIG\TDm\Données_France \F_villes" As F_villes 
Interactive 
Open Table "C:\antoine\ENSEIGNEMENT\M1_SIG\TDm\Donn ées_France\Departmt" As Departmt 
Interactive 



Open Table "C:\antoine\ENSEIGNEMENT\M1_SIG\TDm\Donn ées_France\F_hydro" As F_hydro 
Interactive 
Open Table "C:\antoine\ENSEIGNEMENT\M1_SIG\TDm\Donn ées_France\F_routes" As F_routes 
Interactive 
Map From F_villes,F_routes,F_hydro,Departmt  
  Position (0.59375,-0.0625) Units "in" 
  Width 7.4375 Units "in" Height 6.57292 Units "in"   
Set Window FrontWindow() ScrollBars Off Autoscroll On 
Set Map 
  CoordSys Earth Projection 3, 1002, "m", 0, 46.8, 45.898918964419, 47.696014502 038, 
600000, 2200000 
  Center (648504.6409,2137792.508) 
  Zoom 1260.69294 Units "km" 
  Preserve Zoom Display Zoom 
  Distance Units "km" Area Units "sq km" XY Units " m" 
Set Map 
  Layer 1 
    Display Graphic 
    Global Pen (1,2,0)  Brush (2,16777215,16777215)   Symbol (35,0,12)  Line (1,2,0)  
Font ("Arial",0,9,0) 
    Label Line Arrow Position Right Font ("Arial",0,9,0) Pen  (1,2,0)  
      With CODE 
      Parallel On Auto Off Overlap Off Duplicates O n Offset 2 
      Visibility On 
  Layer 2 
…. 

Figure 11. Exemple de fichier de configuration MapInfo Professional® 

Le document (ainsi que dénommé dans MapInfo Professional®) mémorise la présentation à l’écran, l'ordre 
des couches, la présence d'étiquettes ... pour les restituer tels quels lors d’une utilisation ultérieure. 

Sauvegarde  – Menu Fichier > Enregistrer document sous 

Chargement  – Ouvrir un document au démarrage, ou menu Fichier > Ouvrir et choisir le type .wor . 

 
Travail à réaliser 

On désire réaliser un fichier des capitales européennes de la culture pour les années à venir et le 
géolocaliser pour affichage sur la carte des pays européens. La liste des futures capitales européennes de 
la culture (2009 à 2013) peuvent être trouvées sur la page WWW ci-dessous, avec pointeurs sur leurs 
coordonnées géographiques : http://fr.wikipedia.org/wiki/Capitale_europeenne_de _la_culture   

23. Créer un fichier MS Excell® listant le nom de ces villes, leurs coordonnées et l’année au cours de 
laquelle elles seront capitales européennes de la culture. 

24. Géo-localisez ce fichier 

25. Avec le bloc-notes, consultez le fichier table (.tab) créé à cette occasion par MapInfo Professional®. 
Quelles informations retrouve-t-on ? 

26. Créez une carte faisant figurer les pays européens et les océans (fichiers tables du dossier Europe), et 
en premier plan les villes capitales européennes. 

27. Sauvegardez l’environnement ainsi constitué. Avec le bloc-notes Windows, consultez le fichier .wor  : 
retrouve-t-on les informations attendues ? Rechargez le document pour vérifier que l’environnement a 
bien été sauvegardé. 

Remerciements  – Ce sujet de TP s’inspire pour certaines parties de séances de travail créées par le 
BRGM ou par Elsa Negre. 



TP2 Interrogation d’un SIG : requêtes sous MapInfo 

 

0. Objectifs 

Lors du TP précédent, nous avons fait un rapide survol des fonctionnalités de base du SIG MapInfo 
Professional® . Ce TP nous a permis de voir comment était organisée l’information dans le SIG, et comment 
visualiser cette information. Toutefois, le plus souvent, ce n’est pas l’information brute qui nous intéresse 
mais un point de vue plus élaboré : croisement de données présentes dans plusieurs couches, recherche 
limitée à certains critères etc. Ce sont ces aspects interrogation avancée d’un SIG qui vont nous intéresser 
ici. Notons qu’une bonne partie des notions qui seront expérimentée au cours du TP sont applicables à 
d’autres SIG (voir le cours sur l’interrogation spatiale). 

Ce sujet de TP est divisé en plusieurs parties. Chaque partie suivra la même structure : dans un premier 
temps, un petit tutoriel vous présente certaines fonctionnalités du logiciel. Suit une partie exercice, où il vous 
est demandé d’utiliser ces fonctionnalités pour répondre à certaines demandes. 

1. Sélection graphique d’objets 

1.1. Sélection graphique d’une information 

Le mode d’interrogation le plus simple MapInfo Professional®  sous est celui qui consiste à sélectionner 
graphiquement un ou plusieurs éléments sur la carte et à obtenir en résultat les données attributaires 
rattachés aux objets sélectionnés. Certains modes d’interrogation graphiques savent utiliser plusieurs 
couches en parallèle, il n’est donc pas inutile d’étudier ce mode, qui invocable à l’aide de la palette d’outil 
Général , représentée ci-dessous en affichage horizontal : 

 

    Inversion de sélection 

    Désélection 

 Sélection par polygone 

 Sélection par zone libre 

   Sélection par distance (cercle) 

   Sélection par zone rectangulaire 

  Sélection par pointage 

Figure 1 – Exemple de fichier de configuration MapInfo Professional® 

Les quatre derniers modes de sélection sont assez intuitifs : ils consistent soit à sélectionner un objet en 
cliquant dessus (pointage), soit à sélectionner des objets multiples appartenant à une zone rectangulaire, 
circulaire (par exemple pour choisir les objets situés à une distance maximale d’un point donné) ou enfin 
une zone libre définie à l’aide de points successifs (comme dans toute définition de zone en mode vectoriel). 

En dépit de cette simplicité, notez toutefois que ces modes de sélections tiennent compte de l’organisation 
des couches. Ainsi, si plusieurs couches sont apparentes (transparence des couches, par exemple), les 
objets sélectionnés ne seront toutefois que ceux qui appartiennent à la couche sélectionnable 2 qui est 
placée le plus haut dans la hiérarchie des couches. 

                                                           
2 Revoir le TP précédent si vous avez oublié de cette notion. 



L’outil sélection par polygone  est plus puissant : il permet en effet de définir une zone par pointage dans 
une couche formée de polygones vectoriels, pour ensuite sélectionner les objets ponctuels ou linéaires 
(polylignes) d’une autre couche appartenant à la zone géographique ainsi définie. On peut ainsi, par 
exemple, sélectionner directement toutes les villes d’une région donnée. Attention, cet outil tient lui aussi 
compte de l’organisation des couches : ne seront ainsi concernés, parmi les couches sélectionnable, que la 
couche polygonale et la couche linéaire ou ponctuelle les plus élevées dans la hiérarchie. 

Les deux derniers outils sont complémentaires des précédents : l’outil désélection  annule une sélection 
tandis que l’outil complémentaire  sélectionne tous les objets non sélectionnés, les objets qui étaient 
sélectionnés devenant non sélectionnés. 

1.2. Vue résultat d’une sélection : couche sélectio n 

Lorsqu’on interroge une base de données relationnelle à l’aide d’un ordre SQL de sélection de type SELECT 

… FROM … WHERE, on sait que le SGBD ne duplique pas physiquement les données mais qu’il crée une vue 
temporaire pour afficher le résultat. Cette approche se retrouve avec tous les SIG. Ainsi, tout sélection 
graphique dans MapInfo Professional®  se traduit par la création d’une vue qui apparait dans le SIG comme 
une couche particulière, appelée couche sélection  : celle-ci se retrouve dans la liste des tables accessibles 
à partir du Menu Fenêtres > Données . Si on choisit d’ouvrir la couche sélection, son contenu apparait : il 
s’agit d’une couche purement tabulaire. On remarque que la fenêtre a un nom qui commence par Query  (ici 
Query1 ). C’est ainsi que MapInfo Professional®  nomme toute requête, qu’elle soit le fait d’une sélection 
graphique comme ici ou qu’elle soit plus complexe, comme nous le verrons plus loin. 

  �  
Figure 2 – Exemple de fichier de configuration MapInfo Professional® 

On note par contre que la sélection n’est pas visible dans le contrôle des couches : il ne s’agit en effet que 
d’une sélection des données attributaires, cette vue est donc une vue tabulaire et non spatiale. Il est 
important de comprendre la nature d’une requête Query  et de la couche sélection résultat : 

- Il s’agit de vues virtuelles sans réalité physique : on ne mémorise que la définition de la requête, à la 
manière des vues des SGBD-R définies par la commande SQL CREATE VIEW AS…. Le fait que ces 
données apparaissent parmi les autres tables physiques dans la Fenêtre données ne doit pas vous 
tromper sur la nature virtuelle de la table. 

- La vue reste donc liée à sa table d’origine : si les données de la table évoluent, la couche sélection 
reflétera ces évolutions. 

- Comme pour les vues dans un SGBD-R, il est possible de modifier la base à partie d’une vue sélection. 
Les données seront modifiées dans la table correspondante. 

Ces caractéristiques ne concernent pas que les sélections graphiques et se retrouveront avec les requêtes 
plus complexes étudiées plus tard. 

1.3. Enregistrement d’une vue sélection 

Si l’on veut conserver après une session le résultat d’une requête, il est possible de sauvegarder cette 
dernière. Sélectionnez la vue dans le menu Fenêtres > Données , puis sélectionnez Fichier > 

Enregistrez Table Sous .  MapInfo Professional®  créée alors une table .tab  standard, comme celles que 
nous avons étudiées au cours du TP précédent. Afin de bien saisir la différence avec la vue sélection, 
détaillons les caractéristiques de cette table : 

- Il s’agit d’une table physique ordinaire, c’est-à-dire qu’il y a eu recopie physique du contenu de la vue. 

- La vue n’est plus liée à sa table d’origine : si celle-ci évolue, la nouvelle table n’en tiendra pas compte. 
De même, on ne peut plus modifier le contenu de la table d’origine à partir de cette nouvelle table. 

- Il s’agit d’une table classique qui est donc liée une table .map . Ainsi, si la couche sélection était purement 
sémantique, il y a désormais recopie et lien avec l’information géographique correspondante. 



 
Travail à réaliser 

Dans cette partie, nous allons utiliser une fois encore notre base des départements, associée à la liste des 
villes, des routes et du réseau hydrologique, pour chercher à comprendre plus précisément comment 
fonctionnent les requêtes sous MapInfo Professional®  . 

1. Chargez les tables nécessaires à l’affichage en superposition de toutes ces informations. Toutes les 
couches de données seront sélectionnables et affichées, organisez la hiérarchie des couches pour les 
avoir toutes visibles. 

En utilisant les différents outils de sélection graphique, répondez aux questions suivantes : 

2. Quelle est la longueur de la Loire ? 

3. Quelles est la longueur de la route nationale liant Tours à Bourges ? 

4. Combien d’habitants y-a-t-il à Blois ? 

5. Quelles sont les villes autour de Blois situées dans un périmètre allant juste Romorantin-Lantenay ? 

6. Quelles sont les villes situées dans un triangle Amboise, Vendôme, Romorantin-Lantenay ? 

Nous allons maintenant chercher à mieux comprendre le fonctionnement de ces outils de sélection. 

7. Quels sont les principales rivières de la Manche ? Quelles sont les villes du Territoire de Belfort ?  

8. Jouez sur l’organisation des couches pour arriver à répondre : quelle hiérarchie avez-vous dû choisir 
dans chaque cas pour arriver à vos fins ? 

9. Organisez maintenant vos couches dans l’ordre suivant : F_villes  > F_Hydro  > F_routes  > Departmt . 
Rendez successivement sélectionnables les couches villes, hydrologie et réseau routier. Comment 
pouvez-vous ainsi répondre à la question précédente ? 

10. Fermez la table F_villes . Allez-voir la couche sélection correspondant à la recherche précédente des 
villes du Territoire de Belfort. Que constatez-vous ? Ce résultat était-il prévisible ? 

11. Sauvegardez maintenant la sélection correspondant aux cours d’eau du département de la Manche. 
Fermez toutes les tables, puis ouvrez uniquement la table que vous venez de sauver. Quelles 
observations pouvez-vous faire ? Là encore, expliquez en quoi ce résultat était-il prévisible ? 

  

2. Interrogation complexe : requêtes 

Lorsque l’on désire effectuer une interrogation relativement évoluée de la base de données, les requêtes de 
sélection graphique que nous venons d’étudier apparaissent rapidement trop limitées. On peut ainsi 
imaginer de ne rechercher que les éléments satisfaisant à un certaines condition sur une de leur données 
sémantiques (exemple : villes alsaciennes de plus de 10 000 habitants), ou encore de calculer des données 
de synthèse sur un ensemble d’éléments (exemple : rapport moyen entre population des hommes et des 
femmes par région). Pour réaliser ce type d’interrogations complexes, MapInfo Professional®  dispose de 
deux types de requêtes : 

- Requêtes MapInfo simples  : permet toute opération de sélection sur une table unique et suivant des 
contraintes d’interrogation complexes. 

- Requêtes SQL  : elles permettent d’exprimer tous les type de SELECT SQL sur les données attributaires. 
En particulier, ces requêtes peuvent mettre en jeu plusieurs tables donc, en pratique, plusieurs couches 
de données). 

Ces requêtes se définissent à l’aide de formulaires de saisie. Ce que nous avons abordé dans la partie 
précédente sur les notions de vue virtuelle ou de sauvegarde physique d’une vue résultat s’appliquent à ces 
requêtes évoluées. 

2.1. Requêtes MapInfo : Query 

Les requêtes MapInfo Professional®  s’invoquent à parti du menu Selection > Requêtes  (on trouve 
également dans ce menu l’invocation des requêtes SQL).  Après sélection du sous-menu, une boite de 
dialogue s’ouvre, qui permet de définir les éléments de la requêtes (figure 3, en page suivante). 
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Figure 3 – Définition de requêtes MapInfo Professional® 

L’utilisateur doit préciser, à la suite : 

- L’unique table  (donc la couche de données) sur laquelle portera la requête. Ce champ va correspondre 
à la directive FROM d’une requête SQL. 

- Les critères de sélection , qui s’expriment en fonction d’une expression (cf. supra). Ce champ 
correspond à la directive WHERE d’une requête SQL. 

- Le critère de tri  des résultats (dont on peut demander qu’ils s’affichent ou non à l’exécution). Ce champ 
correspond au ORDER BY d’une requête SQL. 

On remarque également qu’il est possible de spécifier le nom de la couche sélection résultant de 
l’application de la requête. Par défaut, cette couche s’appelera Selection . 

Pour définir les critères de sélection, il est possible d’écrire directement l’expression correspondante, mais 
on peut également faire appel à la boite de dialogue qui s’ouvre en sélectionnant le bouton Expression . 
Celle-ci permet de construire l’expression par ajouts successifs de différents éléments : 

- La colonne , i.e. l’attribut sur lequel porte le critère. La liste des attributs disponibles est directement mis 
à jour par le SIG. 

- Les opérateurs, qui peuvent être aussi bien des opérateurs arithmétiques (opération ou comparateurs >, 
>=, = etc.) ou alphabétique que des opérateurs booléens (AND, OR, NOT) qui permettent de combiner 
plusieurs critères. Notons que l’opérateur d’addition + sert également d’opérateur de concaténation 
lorsqu’il est appliqué à des chaînes de caractères. Plus intéressant, on trouve également des opérateurs 
spatiaux : 

� Contains – A Contains  B est vrai si le point B (ou son centroïde s’il s’agit d’une zone) est situé à 
l’intérieur du polygone de la zone A. A l’inverse, il existe également l’opérateur Within . A Contains  B 
est équivalent à B Within  A. 

� Entirely Within – A within  B est vrai si l’objet B est intégralement situé à l’intérieur du polygone 
de la zone A. Il existe de même un opérateur Contains Entire . 

� Intersect – A intersect B est vrai si A et B se rencontre (i.e. ont au moins un point en commun 
quelle que soit leur nature). 

- Enfin, les fonctions  qui porteront sur les colonnes. Il peut s’agit de fonctions numériques ou portant sur 
les caractères. D’autres fonctions n’ont pas d’arguments : CURDATE() retourne par exemple la date 
courante. Quelques exemples de fonctions utiles : 

� LCase$(chaine) – Mise en minuscule : LCase$("ALSACE")  retourne "alsace" . On notera que les 
chaînes de caractères se représentent entre guillemets. 

� UCase$(chaine) – Mise en majuscule : UCase$("alsACE")  retourne "ALSACE" . 
� Curdate() – Retourne la date courante. MapInfo Professional® traite en interne les formats de date 

"mm-dd-aaaa " et  "mm-dd-aaaa ".  
� Val(chaine)  – Assure la conversion d’un nombre écrit sous forme d’une chaîne de caractères 

alphanumériques. Par exemple, Val("55") retourne 55,  Val("2 canards") retourne 2 (arrêt au premier 
caractère ne représentant pas un chiffre)  et Val("BP 6009") retourne 0 (le premier caractère rencontré n’est 
pas un chiffre). 



� Area(obj, unités) – Retourne  la surface de l'objet considéré dans l’unité de mesure spécifiée (sq 

km pour les kilomètres carrés et sq mi  pour les miles carrés). Notons que obj  est un pseudo-attribut 
qui permet de désigner l’objet en question (il s’agit donc d’un mot réservé). 

� Perimeter(obj, unités) – Retourne  la périmètre de l'objet considéré dans l’unité de mesure 
spécifiée (m pour mètre, km pour kilomètre et mi  pour le mile anglais). 

� CentroidX(obj) – Retourne la coordonnée en abscisse (X) d'un objet point ou du centroïde d'un 
polygone (utile pour transformer des coordonnées). De même, il existe une fonction CentroidX(obj) . 

Consultez le manuel de référence MapInfo Professional 8.0® pour plus de détail sur l’utilisation des autres 
fonctions reconnues par le SIG. 

2.2. Requêtes SQL 

Les requêtes MapInfo Professional®  sont déjà puissantes mais ne peuvent mettre en jeu qu’un seule table. 
Si l’on désire croiser plusieurs couches de données dans une réquête, il faut faire appel aux requêtes SQL, 
qui s’invoquent à partir du menu Selection > Requête SQL . 

 

Figure 4 – Définition d’une requête SQL sous MapInfo Professional® 

La figure 4 vous montre une requête SQL en cours de définition. On remarque que MapInfo Professional® 
intègre complètement le standard SQL. En particulier, il est possible d’utiliser des fonctions d’aggrégat, de 
définir des groupements (GROUP BY en SQL) pour ces calculs aggrégés et toujours de trier les données. 
Notons que si vous ajoutez une à une les tables considérées par votre requête, ajoutera automatiquement 
la condition de jointure dans la zone Critères . 

2.2. Enregistrement d’une requête complexe 

Nous avons vu que les requêtes complexe (requête MapInfo comme requête SQL) offrent des modes 
d’interrogation plus poussés que les outils de sélection graphique. L’autre intérêt d’utiliser ces requêtes 
réside dans la variété de leur mode d’enregistrement. Une requête peut être sauvegardée suivant deux 
points de vue : 

� Sauvegarde du modèle  (dans le menu de création de requête : option sauver modèle ) – Cette 
sauvegarde enregistre la définition de la requête SQL, et non pas son résultat, dans un fichier 
d’extension .qry .  On peut donc réutiliser ultérieurement cette dernière sur d’autres données. 

� Sauvergarde du résultat (menu Fichier > Enregistrer Table Sous , déjà étudié) – Nous avons 
déjà rencontré ce mode lors de notre étude des requêtes de sélection simples. Rappelons qu’ici, 
MapInfo Professional®  crée à une nouvelle table .tab  liée à une information géographique (fichier 
.map) partir des résultats de la requête. La définition de la requête est par contre perdue si on ne 
sauvegarde pas le modèle. Ce mode est utile si l’on désire, par exemple, créer une nouvelle BD 
géographique à partir de sélection d’une base existante. 

 



Travail à réaliser 

Les cours de géographie que nous avons suivis dans le secondaire étaient fortement centrés sur 
l’hexagone. Afin de nous mettre à l’heure européenne, nous allons travailler cette fois sur les données 
européennes qui sont récupérables sur le forum. 

1. Donnez la liste des fleuves européens de longueur supérieure à 500 kms, en ordonnant les résultats. 

2. Reprendre la première requête pour n’afficher cette fois que le nom et la longueur des cours d’eau. Le 
nom sera affiché en majuscules. 

3. Créer une carte qui permette de visualiser ce résultat. On affichera le continent européen sur fond 
jaune, et on visualisera en bleu les cours d’eau sélectionnés, avec affichage de leur nom. 

4. Connaître les capitales de chaque pays européen, c’est déjà pas mal (la capitale de l’Estonie, vous 
sauriez me la donner de tête ?). Mais ce dont on a moins idée, c’est de leur taille respective : les 
capitales de certains pays concentrent la majeure partie de la population nationale, tandis que d’autres 
sont de tailles très raisonnable.  Créer une requête qui donne la liste des capitales, classées par 
importance de la population. On donnera en réponse le nom de la capitale, le pays correspondant et la 
population résultante. 

5. Créer une carte qui permette de visualiser ce résultat de manière graphique directement intelligible. 

6. Comme votre enseignant, vous détestez la chaleur. En prévision du réchauffement climatique qui ne 
peut que se poursuivre dans les années à venir, vous envisagez de déménager dans un endroit plus 
septentrional que la ville de Blois. Pour savoir où vous pourriez élire domicile, créez une requête qui 
vous donne la liste des pays situés au septentrion du 50° parallèle Nord. 

7. Afin de vous permettre d’avoir une idée plus précise sur votre future résidence, créez une requête qui 
vous classe les pays du plus septentrional au plus méridional, en fonction de sa position moyenne. 

8. Créer une requête qui calcul le rapport entre le carré de la longueur de ses frontières et la superficie de 
chaque pays. On fera en sorte d’ordonner les résultats. 

9. Si l’on excepte la Volga (Волга en Russe) qui est située aux confins de l’Asie et de l’Europe, le plus 
long fleuve européen est le Danube (Donau en allemand). Une requête sur notre base de données 
confirme-t-elle ce fait ? Regardez le contenu de la table concernée pour expliquer la situation observée. 
Y-a-t-il indépendance des couches dans ce cas donnée ? Dès lors, pouvez-vous créer une requête qui 
donne la longueur totale de ce cours d’eau ? 

10. Créer une requête qui donne la liste des pays traversés par le Danube. On donnera en réponse la liste 
des pays, et la longueur du cours d’eau dans chaque pays. 

11. Le Liechtenstein (capitale Vaduz) est une minuscule principauté restée partiellement indépendante 
entre la Suisse et l’Autriche. Afin de savoir comment vous y rendre, sauriez-vous créer une requête qui 
donne la liste des routes traversant cet état qui n’a rien d’un état d’opérette, puisqu’il s’agit d’un des 
rares paradis fiscaux situés sur le territoire européen, accusé de fermer les yeux (comme Monaco) sur 
le blanchiment de l’argent sale réalisé dans ses banques. Afin de vérifier la pertinence de votre 
requête, créez une carte montrant ce résultat. 

12. Le modèle vectoriel défini par MapInfo Professional® ne représente pas explicitement les relations 
d’adjacence.  

 a) en reprenant le modèle de relation topologique dit « des 9 intersections », vu en cours, comment 
peut-on exprimer cette relation d’adjacence avec les opérateurs spatiaux connus de MapInfo ? 

 b) Créez alors une requête qui donne la liste des pays qui sont limitrophes du département de l’Ariège 
(eh oui, il n’y en a pas qu’un…). 

13. On désire maintenant avoir la liste des pays adjacents au Luxembourg. Quelle capacité d’expression 
de la norme SQL, nécessaire pour réaliser cette opération, n’est pas intégrée dans MapInfo 
Professional® ? Comment pourriez-vous contourner ce problème ? 

Notons enfin que le mode Sauvergarde du résultat peut être une solution pour pouvoir manipuler des 
données propriétaires sur lesquelles vous n’avez pas de droit de modification : si vous récupérez une telle 
base de données, il vous suffit de sélectionner les informations qui vous intéressent à l’aide d’une requête, 
puis de sauver le résultat : vous obtenez ainsi une BD géographique dont vous êtes propriétaire. 

 



Travail à réaliser 

1. Ouvrez la table des pays européens (EU_Pays.tab ) en mode données. Vérifiez que vous ne pouvez 
pas modifier ces données attributaires. 

2. Créez une requête sélectionnant l’ensemble du contenu de cette table et sauvegardez son résultat pour 
récupérer une BD utilisable. 

3. Utilisez cette nouvelle table pour ne plus garder que les pays de l’Union Européenne. 

4. Modifiez les données attributaires pour remplacer le nom français de ces pays par leur nom dans leur 
langue nationale (exemple : Deutschland pour Allemagne, Polski pour Pologne, Belgique/Belgïe pour la 
Belgique etc…). Fignolez le tout pour obtenir ainsi une belle carte respectant la chartre des langues 
minoritaires de l’Union Européenne. 



TP3 Création de BD géographiques 

 

3. Objectifs 

Après avoir étudié la consultation de BD dans les SIG, nous allons désormais nous intéresser à leur 
création. Plusieurs méthodes sont envisageables pour créer une nouvelle base de données géographique : 

- Importation d’une base existante  ― Il existe des normes d’échanges entre SIG qui facilitent cette 
importation de données. Ce type d’action ne nécessite la compréhension qu’aucune notion particulière et 
est mis en œuvre de manière assez spécifique d’un SIG à l’autre. Nous ne l’étudierons donc pas ici. 

- Création par sélection  ― Nous avons vu au cours du TP précédent comment créer de nouvelles tables 
à partir de tables existantes. Cette procédure peut-être systématisée pour créer de nouvelles bases 
géographiques. Elle ne met en jeu aucune connaissance nouvelle par rapport au TP sur les requêtes 
spatiales. Retenons néanmoins que cette démarche peut-être très utile pour créer une base suivant un 
nouveau point de vue par rapport à la base originale. 

- Vectorisation d’une image raster  ― Il existe des outils permettant de passer d’une image raster à son 
correspondant vectoriel. Ils ne peuvent toutefois être utilisés qu’en mode semi-automatique, c’est-à-dire 
que l’intervention manuelle d’un expert reste nécessaire, ce qui nous ramène au point suivant. 

- Création manuelle ― La création manuelle d’une carte peut se faire en se basant sur des relevés 
géodésiques (technique ) ou, plus fréquemment, en s’appuyant sur une photographie aérienne ou 
satellitaire (image raster). Dans tous les cas, le SIG dispose d’outils pour aider l’opérateur dans sa tâche 
(cf. cours sur les contraintes spatiales). Une fois cette ou ces couches géographiques définies, il reste à 
leur associer des données attributaires. Là encore, cette opération peut être intégralement manuelle ou 
s’appuyer, par exemple, sur une importation de données. 

Au cours de ce TP, nous allons nous intéresser à la création ex-nihilo d’une base de données géographique 
à partir d’une image aérienne. Cette activité, essentiellement manuelle, est quelque peu fastidieuse. Elle est 
toutefois incontournable et permet de mieux comprendre comment est structurée une BD géographique. 

4. Création d’une carte vectorielle : appui sur une  image raster 

La création de cartes a longtemps reposé sur des relevés de terrain. Cette situation prédomine encore pour 
les cartes très précises où, par exemple, un géomètre fait des relevés de positions in situ. Pour les cartes 
d’échelle inférieure, le recours à l’imagerie aérienne ou satellitaire en tant qu’appui au tracé est par contre 
généralisé. C’est pourquoi nous allons ici travailler sur la création de cartes à partir d’une image raster. 

1.1. Ouverture et calage de l’image raster 

La première action à réaliser est d’afficher celle-ci et de la recaler par rapport au référentiel qui sera retenu 
pour la carte en cours de création. L’opérateur va en effet « dessiner » les objets vectoriels d’intérêt « sur » 
l’image raster. Ces opérations d’affichage et de calage ont déjà été étudiés au cours du premier TP. 

1.2. Création de carte : couche dessin de MapInfo Professionnal® 

Quelles que soient les couches ouvertes et leur nature 
(vectorielle ou raster), MapInfo Professional® ajoute en tête de 
hiérarchie une couche Dessin qui joue le rôle d’un calque sur 
lequel l’utilisateur peut dessiner à sa guise. C’est cette couche 
qui va être utilisée pour la création de la nouvelle BD 
géographique : pour chaque thème envisagé (bâti, voirie, 
végétation…), on va décalquer le contour des objets d’intérêt 
sur l’image aérienne. Une fois l’opération réalisée pour un 
thème, on sauvegarde la couche (Enregistrer Table Sous ) 
puis on recrée une couche Dessin. Par défaut, la couche n’est 
pas modifiable : Modifiez ce paramètre dans le Contrôle des 

Couches . 

Figure 1 – Couche dessin dans le contrôle des couches 



 

Pour dessiner dans la couche, il faut utiliser les outils de la palette Dessins. Ceux-ci restent assez limités : 

 
Ajout d’un symbole Tracé d’un segment rectiligne 

Tracé d’une polyligne Tracé d’un arc de cercle 

Tracé d’un polygone Tracé d’un cercle (ou ellipse) 

Tracé d’un rectangle Tracé d’un rectangle à angles arrondis 

Ajout chaîne caractères 
 
 
 
 
 
 

Les icônes en haut de palette servent à définir la géométrie des objets. Un double clic sur l’objet dessiné 
permet de modifier ensuite leur aspect (couleur, forme des contours, symbole…). Les boutons avec point 
d’interrogation en bas de palette permettent de modifier les styles d’objets par défaut. Par exemple, si on 
choisit ici de colorier les polygones en orange, tout nouveau polygone sera créé avec cette couleur de fond. 

Bien souvent, il est nécessaire de reprendre le tracé d’un objet pour l’affiner. Il suffit alors de 
sélectionner l’objet. Aussitôt, les deux boutons de modification de tracé sont rendus actifs : 

- L’outil déplacer nœud  permet de modifier la position des nœuds qui définissent l’objet. On 
retrouve ici la définition du format vectoriel où tout objet est défini par des points d’appuis. 

- L’outil ajouter nœud  permet d’ajouter un point d’appui à l’objet. Cette facilité permet 
d’affiner le tracé d’un segment en le découpant en plusieurs sous-segments. 

   

  Ajouter nœud  

     Déplacer nœud  
 

1.3. Outils d’aide au tracé : fusion de points 

Le tracé d’objets géographiques serait impossible, surtout lorsqu’on cherche une tessalation complète de 
l’espace, sans les outils d’aide au tracé. Le plus utile en pratique dans MapInfo Professional® pour le tracé 
de dessin est certainement l’outil de Fusion de nœuds . Le mode fusion  est directement activable en 
appuyant sur la touche « F » du clavier. Une fois dans ce mode, si vous voulez créer un nouvel objet et si 
vous placez un point proche du point d’appui d’une objet existant, MapInfo sélectionne directement ce nœud 
comme point d’appui pour votre nouvel objet. Cela vous permet ainsi de définir des zones réellement 
adjacentes. Plusieurs précisions complémentaires sur cet outil : 

- Si, en mode fusion, vous maintenez appuyé la touche Maj lors de deux appuis (ou plus) successifs à 
proximité d’un objet, tout le contour de cet objet entre les deux points d’appuis considérés sera pris 
comme appui du nouvel objet : la sélection de zone adjacentes est ainsi accélérée. 

- Le mode fusion peut considérer les points de plusieurs couches en même temps, du moment où celles-
ci sont sélectionnables. Ainsi, vous pouvez par exemple définir aisément la limite d’une zone boisée 
(dans une couche végétation en création) à partir de la rivière et de la route qui la bordent, ces 
dernières étant définies respectivement dans une couche hydrologie et une couche voirie existantes.  

- La fusion de nœud ne s’applique qu’à une distance paramétrable des points 
existants. Cette distance peut être modifiée dans le menu Options > 

Préférences > Fenêtre Carte. Graphiquement un cercle entoure le 
pointeur de sélection en Mode sélection. Son diamètre correspond à celui 
de la zone de fusion. 

Sur la figure ci-dessus à droite, il est fait état du mode AutoNode . Activable par appui sur la touche « N », 
ce mode permet l’ajout automatique de points au fil du déplacement du curseur. Ainsi, un objet n’est plus 



défini par une succession de segments définie par des clics successifs, mais par la mixtiligne obtenue par le 
déplacement réel du curseur.  

1.4. Sauvegarde de la carte 

Pour sauvegarder la couche de données définie à l’aide de la couche Dessin, il ne reste plus qu’à choisir 
l’option Carte > Enregistrer Couche Dessin . Un fichier table est créé, mais également les fichiers . map 
et .id associés : nous obtenons donc une couche complètement définie, avec lien (.id ) entre les niveaux de 
représentation sémantique (.map) et les  niveaux sémantiques (.tab ). Pour l’instant, le niveau sémantique 
est réduit à sa plus simple expression (identificateur des objets). Nous verrons plus loin comment l’enrichir. 

Travail à réaliser 

Pour débuter ce TP, nous allons nous contenter de faire des tracés sans signification pour découvrir 
l’utilisation de MapInfo en création de carte. Pour cela, commencez par charger les tables Departmt.tab  et 
F_hydro.tab . Et zoomez sur la Manche et ses départements limitrophes. 

1. Créez tout d’abord 5 à 6 zones quelconques à l’emporte-pièce. Ces zones nous serviront pour la suite. 
En particulier, faites en sorte que certaines zones se chevauchent, ou soient proches d’un autre sans 
être totalement adjacentes. 

2. Créez une nouvelle zone à contour libre, en activant le mode AutoNode. Donnez lui un coutour 
tourmenté.  

 

3. Sélectionnez l’objet en question et activez l’option de modification de nœud. : Vérifie-t-on bien qu’il 
s’agit d’un objet vectoriel défini par une multitude de points d’appuis ? Le contour ainsi défini est-il une 
polyligne ou une mixtiligne ? Jouez avec la zone en lui rajoutant des points d’appui, en les déplaçant… 

4. Passez en mode fusion de points et rajoutez une zone adjacente à l’une des zones déjà définies. Puis, 
toujours en mode fusion, définissez une zone correspondant à celle du débarquement de Normandie 
en suivant exactement le contour de la côte et le début du cours de l’Orne.  

 

5. Rendez la couche F_hydro non sélectionnable et tâchez de répéter la même opération cette fois à 
l’Est de l’Orne. L’opération est-elle encore possible ? 

6. Enregistrez votre couche dessin. Puis rechargez-là : vérifiez que vous êtes bien en possession d’une 
couche classique de données.  



7. Sous MapInfo, ouvrez la table des données attributaires correspondant à cette couche : quelle 
information est présente pour le moment ? Ceci se retrouve-t-il dans le fichier de description de la table, 
observé cette fois à l’aide du Bloc-Notes ? Nous verrons plus loin comment compléter ces informations 
sémantiques plus loin. 

5. Finalisation : correction de la topologie d’une carte 

En dépit de l’aide apportée par les outils de fusion, il arrive que les objets qui ont été créés enfreignent 
certaines contraintes topologiques. Ou soient simplement inutilement complexes. Deux outils automatiques 
sont là pour vous aider à améliorer la qualité finale de vos couches cartographiques. 

2.1. Contraintes topologiques : élimination des rec ouvrements et des lacunes 

L’outil Correction d’Objets  est invocable à partir du menu Objets > Correction . Il permet d’éliminer les 
recouvrements entre zone, mais aussi de compléter les lacunes, c'est-à-dire de rattacher à une zone les 
espaces non encore affectés. Dans ce cas, MapInfo rattachera cette zone a l’objet avec lequel elle a la plus 
grande frontière commune.  

 

Figure 2 – Boite de dialogue MapInfo Professional® de correction topologique d’objets 

2.2. Simplification des objets 

L’outil Fusion et Simplification d’objets  est invocable par la commande Objets > Fusion et 

Simplification . Il permet des actions aussi diverses que la fusion de nœuds proches pour améliorer la 
tesselation de l’espace (on retrouve ici le principe de la fusion de points d’appui), la simplification des 
contours en éliminant les points d’appuis non réellement nécessaires, ainsi que la suppression des 
polygones scories, i.e. des zones de trop petite taille. 

 

Figure 3 – Boite de dialogue MapInfo Professional® de simplification d’objets 



 

2.3. Agrégation d’objets 

Enfin, il est possible de fusionner plusieurs objets de même type pour n’en créer qu’un seul. S’amuser à 
définir plusieurs objets pour ensuite n’en faire qu’un peut semble bizarre. En pratique, cela peut être très 
utile. Songeons par exemple à une couche de données de type voirie, ou il est plus facile de définir des 
portions de rues ou routes que de créer une zone unique très complexe et à trous correspondant à 
l’ensemble du réseau routier d’une ville.  

Notons par ailleurs que MapInfo Professional® propose également des outils pour agréger des objets 
partageant certaines caractéristiques dans une base de données déjà créée. Nous avons évoqué cette 
possibilité dans le cours sur les BD multi-échelles. Nous n’étudierons pas ce point ici. 

Pour agréger des objets sous MapInfo Professional®, il faut tout d’abord définir une zone cible, et ensuite 
les objets qui doivent lui être rattachés. Pour cela : 

1.  Sélectionnez un objet cible unique et choisissez l’option Objets > Définir Cible . L'objet apparaît 
dans un style différent pour indiquer qu'il est l'objet cible. 

2.  Sélectionnez un ou plusieurs objets cartographiques dans toute couche de la fenêtre Carte (on peut donc 
faire des fusions entre couches différentes). 

3.  Choisissez l’option Objets > Assembler . Si les objets n’ont aucune autre donnée attributaire que leur 
identificateur (cas d’une carte en cours de création), la fusion sera automatique. Sinon, une boîte de 
dialogue Agrégation des Données apparaît pour vous demander comment agréger, champ par champ, 
les données attributaires des objets individuels dans l’objet complexe résultant. Par exemple, on peut 
imposer une valeur, prendre la somme des valeurs du champ dans les objets donnés etc… 

 

Figure 4 – Boite de dialogue MapInfo Professional® d’agrégation d’objets 

Notons que l’information sur les objets préexistants n’est pas perdue : on a simplement créé un objet 
complexe (cf. cours de modélisation informatique de l’information géographique) à partir d’objets unitaires.  
Il est dès lors possible de réaliser l’opération inverse de désassemblage (option Objets > Désagréger ) 

Travail à réaliser 

Si vous l’aviez fermée, ré-ouvrez la couche de données que vous avez tracé et sauvegardé précédemment. 

1. Utilisez l’outil de respect des contraintes topologiques pour éliminer les recouvrements et lacunes entre 
les différentes zones. Le cas échéant, vous devrez paramétrer l’outil pour qu’il s’adapte aux 
caractéristiques de vos tracés. 

2. Testez enfin l’outil de simplification des tracés. Par exemple, étudiez l’influence de la distance minimale 
entre les nœuds pour la simplification des contours. 

3. Fusionnez deux zones de votre choix de l’ex-couche dessin. 

4. Pour terminer, essayez de fusionner plusieurs départements (par exemple pour former une région 
administrative) en cherchant à garder des informations sémantiques cohérentes pour l’objet résultant. 



 

5. Ouvrez la table correspondant en mode Données : qu’observez-vous ? Ce résultat était-il attendu ? 

6. Rattachement de l’information sémantique 

Nous avons vu que les données attributaires liées à la couche tracée se limitaient pour l’instant à un seul 
champ : l’identificateur des objets, qui permet de faire le lien entre niveaux géographiques et sémantiques. 
Deux méthodes principales peuvent être envisagées pour rajouter des données attributaires à cette nouvelle 
couche : 

- Importation de données  – Dans ce cas, on dispose déjà d’un fichier de données où les données 
attributaires sont géolocalisées. Il reste à faire la correspondance entre ces données et les zones 
géographiques. Cela pose la question du géocodage de ces données, point qui a déjà été étudié dans 
un TP précédent. 

- Création ex-nihilo des données  – Dans ce cas, toute l’information est à créer. C’est ce cas de figure 
que nous allons étudier ici. Deux actions sont à réaliser ici : tout d’abord modifier la structure de la table 
des données attributaires (nouveau champs), puis rentrer les données. 

3.1. Modification de la structure de la table de do nnées attributaires 

Pour modifier la table, il faut la rendre modifiable. Si on l’ouvre en mode Données, on constate bien que 
celle-ci ne comporte que le champ unique d’identifiants des zones. Pour rajouter les  champs correspondant 
à la structure de la relation recherchée , on active l’option Table > Gestion Table > Modifier 

Structure .  Une boite de dialogue s’ouvre, qui nous permet de modifier à loisir la structure de la table. 

 

Figure 5 – Boite de dialogue MapInfo Professional® de modification de la structure des tables attributaires 

Une fois les nouveaux champs définis, on valide la modification. L’affichage de la table disparait, ce qui est 
normal, puisqu’elle n’a plus la même structure. 

3.2. Ajout ou modification de données attributaires  

Pour rajouter ensuite les données, il ne vous reste qu’à ouvrir la table en mode de données et rentrer les 
informations comme dans un tableur. Notez que vous procéderiez de même pour modifier les données 
d’une couche existante … et modifiable. 

 



Travail à réaliser : premier projet SIG 

Pour ce premier projet, vous allez devoir créer ex-nihilo une carte en vous appuyant sur une image aérienne 
existante. Ce projet vous demandera de mettre en œuvre les connaissances acquises sur le calage d’image 
raster puis sur la création de cartes. Plus précisément, il vous est demandé de faire la cartographie de la 
ville de Paris dans la zone de la Place de la Concorde et des Champs Elysées. L’image aérienne 
correspondant au projet se trouve sur la page WWW de cet enseignement : Paris_Concorde.jpg . 

 

Pour recaler l’image Raster, vous pouvez aller chercher les coordonnées de certains points significatifs sur 
Google Earth. Je vous donne cependant certaines coordonnées que j’ai calculées moi-même : 

- Obélisque : 48°51’ 55,7" N et 2° 19’ 16,01 " E 

- Coupole du Théâtre Marigny : 48°52’ 07,38" N et 2° 18’ 49,34 " E 

- Coupole du Grand Palais : 48°51’ 58,05" N et 2° 18’ 45,15 " E 

A partir de cette image, il vous est demandé de créer une base de données géographique comportant : 

- les zones bâties 
- les zones végétalisées (parcs essentiellement) 
- les cours d’eau 
- la voirie 
- les monuments les plus significatifs (Grand Palais, Petit Palais, Obélisque de la Concorde) 

Le projet sera à rendre sous la forme d’une base de données compressées (.rar  ou .zip ) comportant tous 
les fichiers nécessaires à sa visualisation, accompagné éventuellement d’un fichier document .wor    



TP4 Analyse thématique : compléments 

0. Objectifs 

Au cours du premier TP1 de découverte de MapInfo Professional, nous avons exploré les principales formes 
d’analyse thématique réalisables avec ce SIG. Ce TP, assez bref, a pour objectif de vous faire découvrir 
quelques fonctionnalités additionnelles d’analyse thématique suivant deux directions :  

- Choix des champs de valeurs sur lesquels se base l’ analyse  ― Nous verrons ici comment utiliser 
des champs calculés et non plus des données brutes présentes dans la base de données, et comment 
utiliser par jointure des valeurs issues d’autres tables. 

- Types de graphisme  ― Nous étudierons de nouveaux types d’affichage pour rendre compte 
visuellement du résultat de l’analyse : coloration par valeurs individuelles, par densité de points et enfin 
coloration sous forme de champs continus. Cette dernière analyse nous ramènera à la création d’image 
Raster, mais également à l’affichage de résultats sous forme 3D voire stéréoscopique. 

Ce TP n’abordera pas la question de la mise en page des résultats obtenus pour intégration, par exemple, 
d’un rapport de synthèse. Ce point est en effet trop spécifique au SIG utilisé. Il s’agit néanmoins d’un aspect 
important de la finalisation d’une analyse thématique sous un SIG. Les personnes intéressées se 
rapporteront à la documentation MapInfo Professional pour plus de renseignement sur la mise en œuvre de 
cette mise en forme avec ce SIG. 

Les points abordés au cours de ce TP vous donneront tous les éléments pour mener à bien les analyses 
thématiques demandées au cours de second projet SIG, présenté en fin de TP. 

1. Champs de valeurs pour l’analyse thématique 

Jusqu’ici, les analyses thématiques que nous avons réalisées se sont basées sur un des champs de la table 
de données considérées. L’analyse thématique peut toutefois avoir une portée plus grande : 

a) On peut tout d’abord la faire porter sur une combinaison de différents champs de valeurs de la 
table. Par exemple, si on dispose d’une table donnant la population et la superficie d’un ensemble 
de régions, il peut être intéressant d’analyser la densité de population par régions : on fera ici une 
analyse sur une variable  calculée exprimé par l’expression  population / superficie. 

b) La donnée que l’on veut analyser au regard de la carte considérée peut se trouver dans une autre 
table. Par exemple, on peut a voir une table qui localise des régions, et une autre qui liste un 
ensemble de villes sur un territoire plus vaste. Une jointure  entre les deux tables nous permet 
d’analyser la répartition de la population urbaine par région. On réalise donc une analyse où une 
table définit la segmentation géographique et une autre les données à étudier. 

Nous allons maintenant étudier la mise en œuvre de ces deux fonctionnalités. 

1.1. Variable d’analyse calculée : expressions 

L’analyse sur champs calculés s’invoque comme sur un champ de valeurs brutes : une fois la table 
concernée chargée, on lance l’analyse (menu Carte > Analyse Thématique ) en choisissant le type 
d’analyse désirée. Simplement, à l’étape 2/3, on ne choisit pas un champ particulier comme variable 
d’analyse mais l’option expression .   

 �  

Une fenêtre de dialogue s’ouvre pour définir l’expression de calcul en précisant les champs (colonnes), 
opérateurs et fonctions applicables. Ici, la variable calculée correspond à une densité de population. 



1.2. Analyse thématique sur plusieurs tables : join ture 

Dans l’exemple précédent, le calcul de la variable d’analyse se base sur des champs appartenant à la table 
considérée. Il est cependant possible de travailler avec les champs d’une autre base. Dans ce cas, ce n’est 
pas l’option expression  qu’il faut choisir lors du choix de variable, mais l’option jointure 3. Une fenêtre de 
dialogue (Mettre à jour Colonne ) s’ouvre alors, qui nous permet de préciser les conditions de jointure : 

 �    

Plusieurs choses doivent être précisées dans cette boîte de dialogue : 

- la table de jointure qui contient les données sur lesquelles portera l’analyse 

- la colonne de jointure au sein de cette table. Remarquons qu’ici encore, on peut utiliser un champ brut ou 
au contraire un champ calculé (option expression ). 

- le type de calcul à réaliser (champ calculer ). Ce calcul est analogue à l’utilisation des fonctions 
d’agrégat dans une requête SQL comportant un GROUP BY. Expliquons ce point sur l’exemple de la 
jointure d’une table région  avec une table ville . Plusieurs villes peuvent être localisées dans une 
région donnée. Dès lors, si l’on fait une analyse par région sur la population urbaine, il faut savoir si la 
variable qui nous intéresse est la somme de la population de toutes les villes régionales, sa moyenne 
etc… Cette fonction d’agrégat est à préciser ici.  

Enfin, un dernier bouton de contrôle permet de choisir le type de jointure à réaliser. Il ouvre une boîte de 
dialogue (Définir Jointure ) qui permet de définir au choix : 

- une jointure classique au sens des bases de données relationnelles 

- une jointure géographique spécifique aux SIG (contient, à l’intérieur de, intersecte ).  

 

 
Travail à réaliser 

Dans cette partie, nous allons nous intéresser aux données de population des villes et départements 
français. Chargez les tables correspondantes à partir des données disponibles sur le site WWW du cours. 

1. Réalisez une analyse thématique permettant de colorier les différents départements en fonction de la 
proportion de femmes dans l’ensemble de la population départementale. 

                                                           
3 Remarquons que, très logiquement, l’option de jointure n’est affichée que si plusieurs tables sont ouvertes. 



2. MapInfo Professionnal propose deux fonctions de calcul de superficie à partir d’un objet géographique 
affiché sur une carte : la superficie réelle (Area ), qui tient compte de la projection utilisée pour se 
ramener à la géoïde réelle, et l’aire cartésienne (Cartesian Area ), qui elle estime la superficie de 
l’objet à partir du repère cartésien plat de la carte projetée. Réalisez une analyse sur chaque 
département pour étudier le rapport entre ces deux variables calculées. Qu’observez-vous ? Comment 
expliquez-vous ce résultat ? 

3. A la révolution, les limites des départements ont été définies de la manière la plus rationnelle possible 
afin que toute commune ne soit pas distante de plus d’une journée de cheval de la préfecture. 
Idéalement, la forme optimale d’un tel découpage serait donc un pavage régulier du territoire, ce qui 
n’est visiblement pas le cas. Une petite analyse va nous le montrer graphiquement. Réalisez une 
analyse qui permet de visualiser le rapport entre le périmètre et la superficie des départements. Quelle 
est la forme des départements présentant des valeurs extrêmes sur cette variable calculée. Ce résultat 
est-il cohérent avec vos attentes ? 

4. La table de données Departmt.tab  donne la superficie de chaque département. Cette information 
administrative est-elle cohérente avec le calcul de surface que peut opérer MapInfo sur les objets 
géographiques correspondant ? Réaliser une analyse thématique pour apprécier les écarts à la réalité.  

5. Quels sont les départements les plus ruraux de France ? Pour cela, réalisez une analyse thématique 
qui permette de colorier les départements en fonction de leur proportion de population urbaine dans la 
population totale. 

6. Durant la seconde moitié du XX° siècle, la Franc e a connu un fort exode rural qui s’est traduit par une 
expansion non maitrisée de très grandes agglomérations autour du triptyque banlieues ghetto ou 
pavillonnaires / hypermarchés et zones industrielles / congestion automobile dont on supporte 
désormais les conséquences. Exception faite de la Corse et du Limousin désertifiés, une seule région a 
su échapper à cette évolution : la Bretagne, dont la qualité de vie est due au maintien de multiples 
villes-relais de 3000 à 10000 habitants où l’on trouve encore cinémas, théâtres etc… sans avoir à faire 
100 kilomètres en voiture. Cet état de fait s’explique : jusque dans les années 1980, les ouvriers 
bretons étaient le plus souvent des agriculteurs pour lequel le travail à l’usine ne représentait qu’un 
complément de salaire au revenu de leur exploitation. Cette région semble malheureusement rentrer de 
le rang actuellement depuis la révolution de la politique agricole commune (PAC) et également du fait 
de  l’arrivée massive de retraités franciliens privilégiant (ah, la ville à la mer !) une installation dans les 
grandes agglomérations. Seule l’immigration anglaise en centre Bretagne semble à même de 
contrebalancer cette regrettable évolution. Il serait intéressant de voir quelles autres régions ont su, 
dans une moindre mesure, conserver également un réseau de petites villes au dépend d’une grande 
agglomération centrale. Pour cela, faire une analyse thématique qui affiche la taille moyenne des villes 
par département. Pouvez-vous expliquez certains résultats visiblement aberrants ? 

2. Analyse thématique : formes avancées de visualis ation 

Lors du premier TP, nous n’avons pas découvert tous les types de graphiques proposés par MapInfo 
Professional : nous allons maintenant étudier les trois derniers types du menu Carte>Analyse Thematique . 

2.1. Analyse par valeurs individuelles 

Toutes les analyses étudiées jusqu’ici portent sur la classification d’une variable dans un certain nombre de 
plages de valeurs (classes). A l’opposé, l’analyse par valeurs individuelles ne fait aucun regroupement : elle 
accorde une classe à chaque valeur. Supposons par exemple que l’on ajoute un champ parti_politique 

à la table Departmt.tab , afin de décrire la couleur politique dans chaque département. A l’aide de l’analyse 
par valeurs individuelles, il est ainsi possible de colorier la carte de France par parti politique. Pour réaliser 
cette analyse, il faut sélectionner l’option Val. Individ.  dans le menu Carte>Analyse Thematique . 
L’analyse par valeurs individuelles concerne aussi bien les objets polygones que ligne ou points. 

2.2. Analyse en nuages de points 

L’analyse en nuage de points ne peut s’appliquer qu’aux champs de valeurs numériques et sur des objets 
de type polygones. Son principe est simple : il consiste à remplir chaque zone polygonale par des points de 
d’autant plus nombreux que la variable analysée est grande dans cette zone. Pour cela, on définit au 
préalable la valeur que représente un point unique. Si la variable observée sur une zone donnée est N fois 
plus grande que cette valeur de point, la zone sera remplie par N points disposés de manière aléatoire. 



Pour réaliser cette analyse, il faut sélectionner l’option DensitéPoints  dans le menu Carte>Analyse 

Thematique . Dans l’étape 3/3 de définition de l’analyse, ne pas oublier d’aller sélectionner le bouton 
contrôle Paramètres  pour définir, entre autres, le nombre d’unités que représente chaque point.  

 �  

2.3. Analyse en coloration continue : rasterisation  

Le dernier type d’analyse va nous permettre d’étudier à nouveau le format Raster. Elle consiste en effet à 
créer un champ de valeurs continues sur l’espace géographique à partir de données sémantiques discrètes 
associés aux objets géographiques d’une carte vectorielle. 

Prenons un exemple pour étudier l’utilité de ce type d’analyse. Supposons qu’on dispose d’une table 
donnant les températures moyennes région par région. Il est alors possible de faire une analyse thématique 
en classes de valeurs pour colorier chaque polygone représentant une région en fonction de cette 
température. Le résultat nous donnera une idée du climat des différentes régions françaises, mais sera un 
peu artificiel : en effet, 2 villes situées à 25 kilomètres l’une de l’autre (Belfort et Mulhouse par exemple), 
mais appartenant à des régions différentes, sembleront connaître un climat différent alors qu’il n’en est rien. 
Dans ce cas, il serait plus pertinent de créer une carte illustrant des gradients continus de température d’une 
région à l’autre : nous serions alors en présence d’une image Raster (appelée ici grille ) où chaque pixel 
porterait une information de température spécifique. 

Comme nous l’avons vu en cours, la rasterisation consiste à calculer un champ de valeur continu à partir de 
quelques valeurs définies sur des points espacés (objets points ou centroïdes d’objets polygones de la carte 
vectorielle). On opère pour cela par interpolation des données sur tout l’espace géographique. MapInfo 
Professional propose deux modes d’interpolation : 

- Une interpolation bilinéaire classique (cf. cours chap. II) appelée ici IDW, 

- Une interpolation TIN à base d’un réseau de triangles irréguliers. Les réseaux TIN sont normalement 
utilisés pour modéliser vectoriellement les espaces en trois dimensions. Ici, ils sont simplement utilisés 
comme surface d’interpolation : on créée des triangles à partir des points valués de la carte vectorielle, 
en tentant de respecter les critères de Delaunay. L’équation des ces triangles dans l’espace 3D (2D + 
variable observée) donne ensuite à la valeur de la variable en tout point : il est donc aisé de créer à partir 
de cette description une image raster suivant une grille de pixels prédéfinie. 

L’interpolation TIN respecte mieux les valeurs aux points déjà valués de la carte vectorielle originelle. Pour 
que son rendu soit acceptable, il faut par contre que le nombre de points initial ne soit pas trop limité. 

Pour réaliser l’opération de rasterisation  nécessitée par l’analyse thématique en coloration continue, il faut 
choisir l’option de coloration continue (Col. Continue ) dans le menu Carte > Analyse Thématique .  La 
boîte de dialogue qui apparait ensuite nous donne le choix entre des grilles de type IDW ou TIN.  

L’étape suivant nous permet de préciser où doit s’arrêter la création de 
l’image raster (Option de la grille ) : on associe pour cela la limite 
de grille à une table. Si le choix est aucune  comme sur la figure de 
droite, la grille sera créée sur tout l’espace visible. Dans le cas de la 
France, par exemple, l’interpolation concernera la zone maritime 
comprise entre la métropole et la Corse. On peut au contraire limiter 
l’affichage du champ continu à la zone couverte par les objets de la 
carte vectorielle. Précisez dans ce cas le nom de la table 
correspondante. 

On remarque, en bas de la boîte de dialogue, que la grille raster qui 
sera créée correspondra à un fichier d’extension .mig .  

La dernière étape permet un paramétrage final de l’analyse. On peut 
repréciser ici le type d’interpolation utilisé.  



Dans le cas d’une interpolation IDW, le bouton de contrôle paramètres  permet de préciser à la fois la 
dimension d’une maille de base de la grille (champ Taille de la cellule ) ainsi (entre autres) que la taille 
du rayon sur lequel sera basée le calcul de l’interpolation. 

  

Dans le cas d’une interpolation de type TIN, on peut également préciser la taille de la grille, ainsi que 
différents paramètres contraignant la création des triangles irréguliers. Par exemple, le paramètre angle  
donne l’angle minimal que devront avoir tous les sommets des triangles. 

2.4. Analyse en coloration continue : visualisation  3D et stéréoscopique 

L’image raster créée représente, à l’aide d’une gamme de couleurs, un champ de valeurs continues sur 
l’espace géographie 2D considéré. Il est tentant de représenter cette variation de la variable continue dans 
un espace en trois dimensions. L’outil Carte > Créer une Vue3D  réalise cette opération. Vous pouvez 
pour cela préciser le point de vue à partir duquel vous observez la carte 3D, ainsi que la couleur et la 
direction de la source lumineuse éclairant la scène : 

�  �  

Il n’est pas nécessaire de s’attarder sur ces paramètres : une fois la vue 3D créée, ils peuvent être modifiés 
directement à la souris en utilisant les boutons de zoom et de déplacement standard. 

Si vous désirez renforcer l’aspect tridimensionnel de votre image 3D, l’appui sur la combinaison de touche 
Ctrl-F3  créée une image stéréoscopique : vous pouvez dès lors percevoir le relief à l’aide de lunettes 
stéréoscopiques 3D de type rouge-vert. Rappelons à ce sujet que la vision stéréoscopique est très utile pour 
la perception des reliefs lors de la constitution des cartes. 

 Ctrl-F3 �  



Travail à réaliser 

1. Coloriez automatiquement la carte des pays européens pour arriver au rendu suivant, où chaque pays a 
une couleur différente, mais également le réseau routier de chaque pays : 

 l  

2. Cherchant en vain l’âme sœur depuis trop longtemps, vous vous dites que pour maximiser vos chances 
de conclure, mieux vaut aller dans un endroit où les personnes de l’autre sexe sont surnuméraires ! Pour 
savoir où vous installer à la fin de votre Master, créez donc une carte de France qui sera remplie, 
département par département, de points représentant chacun 500 femmes (ou hommes suivant votre 
cas et/ou vos goûts) surnuméraires. 

 

Au passage, ne croyez pas trop au père Noël : en Chine et en Inde, les hommes sont plus nombreux que 
les femmes du fait de nombreux homicides à la naissance d’une fillette (prééminence pour un garçon dans 
la Chine de l’enfant unique, coût à prévoir de la dot dans l’Inde hindouiste). A l’opposé, en France, si les 
femmes sont majoritaires, c’est simplement parce qu’elles vivent plus vieilles. Si vous recherchez une 
compagne, il y a donc de forte chance que les filles surnuméraires soient de sympathiques grands-mères 
édentées de 90 ans… 

3.  Les nuages de points ne vous semblent pas assez parlants ? Reprenez cette analyse thématique en 
effectuant cette fois une coloration continue. On choisira un mode d’interpolation bilinéaire et on étudiera 
l’influence de la taille des mailles de la grille et du rayon de calcul d’interpolation.  

Nous allons terminer ce TP par la création d’une image altimétrique raster puis 3D à partir d’une carte 
vectorielle. Ce travail portera sur la table de données mntpur_point , que vous récupérerez sur le site 



WWW de cet enseignement. Cette table vectorielle décrit l’ensemble des points côtés en altitude d’un 
espace géographique de l’agglomération lyonnaise. Nous allons donc en profiter pour recréer un modèle 
numérique de terrain (MNT) raster. Mais notez bien que les opérations que vous aller réaliser seraient 
identiques pour toute analyse thématique en coloration continue. 

4. A partir de la carte vectorielle des points côtés, créez un modèle numérique de terrain en couleurs. Créez 
plusieurs MNT pour étudier l’influence du mode d’interpolation et de son paramétrage. 

5. Créez une vue 3D à partir du MNT obtenu. 

6. Enfin, passez en mode stéréoscopique et chaussez vos lunettes : on s’y croirait, non ? 

 


